
12 useful things to know in Excel V1 Oct  2022 1 

12 useful things to know in Excel 
Contents 
Switch between open Excel windows ................................................................................................... 2 

Start a new line within a cell ................................................................................................................. 2 

Ways to insert rows or columns easily ................................................................................................. 3 

How to tell which column is sorting data ............................................................................................. 6 

Finding workbooks that you recently opened or worked on. .............................................................. 7 

How to see which Excel files have been shared with you .................................................................... 8 

Concatenate (Merging columns) .......................................................................................................... 9 

Convert text to columns – splitting one column into two .................................................................. 12 

Putting data into middle of other cell data ......................................................................................... 15 

Add commands into quick access toolbar .......................................................................................... 17 

View side by side + synchro scrolling .................................................................................................. 19 

Data validation .................................................................................................................................... 21 

 

 
  



12 useful things to know in Excel V1 Oct  2022 2 

Switch between open Excel windows 
Do you often have more than one Excel workbook open and have to switch between them to 
work? There is a command that lets you switch easily within Excel. 

Click on View tab to access the Window group.  

 

Choose the ‘Switch Windows’ command and click on the open Excel workbook you want to see 
next. 

 

It will appear in front of everything else on your screen. You can then use this to go back to your 
original spreadsheet. 

 

Start a new line within a cell 
If you are inputting into a cell in a spreadsheet and want to start a new line in the same 
cell, this is called a line break within a cell. You can use this to wrap text more accurately 
than the ‘Wrap text’ command in your ribbon, for example with a list of roles. 

1.      To input a line break, type the first thing you want in the cell and leave your cursor 
after the last character. 

2.      Then press the ALT key down and press the Enter key.  
3.      Type your next line. 

 
 
4.      Repeat this process until you have everything you want in the cell.  
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Ways to insert rows or columns easily 
There are several ways to do this. Although the following examples show how to insert 
rows, all of these methods will work for inserting columns too.  

A. You can use a keyboard shortcut to insert rows or columns 
1. Click onto the row where you want to add one. 
2. Hold the Alt key down whilst you press I key and then R key. (Remember – IR for 

Insert Row). 
3. It will add a row above where you are clicked on. You can keep Alt pressed down 

and repeatedly press I then R to add multiple rows.  
4. For adding columns, use Alt and the I and C keys (IC for Insert Columns). 

 
 

B. You can click on the ‘Insert’ command in the Cells group on Home tab 

 
 
1. This should let you repeatedly click onto it and insert multiple rows. 
 
2. If you click onto a whole column, then click Insert, it will insert new columns instead.  

 
 

C. Add ‘insert row’ to the quick access area of your Excel files. 

The ‘quick access area’ is the space along the top left of your Excel workbooks. A couple of 
commands may already be there (e.g. Undo) but you can add whatever you want there.  

 

1. Click on the dropdown arrow and choose ‘More Commands’ at the bottom of the list. 
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2. Find what you want in the list on the left. It looks complicated but all you need to know 
is that on the left are commands available to add, on the right are commands already in 
your QAT, and the Add/Remove buttons are in the middle. 

 
3. It defaults to Popular commands, but if you can’t find what you want in that list, just 

use the drop-down arrow to select another group like All Commands, Home tab 
commands, etc.) 
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4. Click onto the command you want to add to your quick access area, e.g. Insert Sheet 
Rows, and then press Add so it appears in the list on the right.  

 
5. Click OK to apply the change and close the dialogue box. 

 
6. It is now in your quick access area along the top of Excel. It stays there for every Excel 

workbook you open.  

 
7. To add multiple rows, just press the icon multiple times and new rows will be inserted 

into your worksheet. 

  



12 useful things to know in Excel V1 Oct  2022 6 

D. You can right click and choose ‘Insert’. Then choose ‘entire row’ or ‘entire column’. 

 

E. Finally, if you drag your cursor to highlight, say, six rows, then use any of these 
methods for inserting, it will add six rows. The same with columns.  

The new rows / columns are inserted in front of the first of the row/column you 
highlighted.  
 

How to tell which column is sorting data 
If you have a lot of columns and have sorted your data alphabetically, numerically, etc, you 
might have forgotten which column you sorted by, especially if you last used the 
spreadsheet a while ago.  

Look for the column heading that has the small arrow pointing upwards or downwards. 
This is the column data by which the spreadsheet is sorted. An arrow upwards means the 
data is sorted in ascending order; a downward arrow means descending order. 
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Finding workbooks that you recently opened or worked on. 
Do you know that when you open a blank Excel workbook, you can easily see your recently 
accessed workbooks and any that have been shared with you?  

Before you click onto ‘Blank workbook,’ there is an Excel landing page with sections called 
New, Recommended for you, Recent, Pinned and Shared with me (see next page). 

 

Recommended for you: this displays the most recent 5-6 Excel files you have accessed as 
‘tiles’ so you can see a page of them. (You can hide this section via the dropdown arrow in 
front of Recommended) 

Recent: if you click into ‘Recent,’ you can see a longer list of your recent workbooks with 
the date you modified them. Using the ‘More workbooks’ arrow at bottom right, you can 
access workbooks you opened from today, yesterday, this week and last week.  

Most useful of all, you can open any of these Excel files from this list so you don’t have to 
go hunting for files you worked on or read last week or find the email they came to you on. 

You can even pin any of these Excel workbooks to your Pinned list so you can easily find it 
later. Just use the Pin icon. 
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How to see which Excel files have been shared with you 
Do you know that when you open a blank Excel workbook, you can easily see any 
workbooks that have been shared with you?  

Before you click onto ‘Blank workbook,’ there is an Excel landing page with a section called 
‘Shared with me.’ 

 

Click onto ‘Shared with me’ and it will display the list of Excel workbooks that have been 
shared with you by colleagues. It gives you the file name, and when it was shared and by 
whom.  

   

Clicking onto the ‘More workbooks’ arrow at bottom right will display a full list.  

Handily, you can open any of these files from this list, so you don’t have to go hunting for 
the files you know were shared with you. 
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Concatenate (Merging columns) 
This complicated word just means to link together.  

The Concatenate function is a useful tool in Excel if you want to combine two or more 
columns into one – e.g. First Name and Surname. Concatenate works for rows too but this 
example is for columns, which is a more common use.  

1. Choose a column for the concatenated data to go into. In this example, Full Name. 

 
 
2. Click into the first cell of that new column – e.g., cell number D2 after the column 

header. 
 
3. Click into the Insert Function area – the fx in top left. 

 
 
4. Choose ‘Concatenate’ from the list or type it into the ‘Search for a function’ box and 

click Go to find it. 

 
 
5. Click OK 
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6. This brings up your ‘Function Arguments’ box. Don’t panic – all you need to do is tell 
Excel which two (or more) columns you want to merge. 

 
 
7. In Text1 box, type the number of the cell you want to appear first in the new cell, e.g. 

First Name, which in this example is B2. OR you can simply click into B2 and the Text1 
box will enter the data itself.  
 

8. Repeat the same step for Text2 box, e.g., click onto C2 or enter C2 for the Surname. 

 

Note: when you click into the Text2 box, Excel will automatically give you a Text3 box. You 
do not have to use this if you don’t need it. 

9. Make sure to add a space if you need one. If you want anything like a space or comma, 
you need to input that character into Text2 box in inverted commas (e.g., “ “ or “,”) 
then continue with the data in Text3. For example, B2 is First Name and C2 is Surname, 
but if you want a space or comma between those names:  

 

Note that Excel shows you in bottom right how the new cell will look before you press OK. 

10. Click OK 
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11. Your new cell will display with the merged data. 

 

The example above shows the formula in the Functions bar as: B2,” “,C2” because it is for 
row 2. Therefore, the data in cell D2 is First Name (B2) plus a space, plus Surname (C2). 

12. To reproduce this in other cells, just grab the ‘fill handle’ of the concatenated cell and 
pull it down through the cells where you want to duplicate the function.  

 
Excel is clever enough to know that you don’t want the same name in all of those cells, you 
want the same function to be performed. 
 
13. You can see now that all the names in Columns B and C are concatenated in column D. 

You can also see that Excel has amended the formula for each row, e.g., row 4 now says 
B4 and C4 instead of B2 and C2.  

 

14. This is the Concatenate function. Obviously, you can do it with multiple columns 
should you need to combine more than two. 

Important: remember that your new column (D in this example) is only populated because 
there is data in your other columns (e.g., B and C). If you remove the data from those cells, 
the data in your concatenated cells will disappear.  

Tip: If you need the new cells but not the originals (e.g., 
First Name and Surname not required now you have a Full 
Name column created), copy your new column and paste it 
back in using Values paste option. If you use normal Paste, 
it brings the formula with it.  
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Convert text to columns – splitting one column into two 
The ‘text to columns’ function allows you to divide the contents of one cell into separate 
columns. 

For example, you may want to separate a column called Full Name into columns called First 
Name and Surname. 

The first thing to remember is that when you separate one column into two, you need to 
have figured out where you want the new columns to go. 

1. If needed, create new columns for the separated data – e.g. First Name and Surname.  
 

2. Select the column with the data you want to separate, e.g., here Full Name in column 
B. 
 

3. On the Data tab of Excel, click on Text to Columns function within the Data Tools 
group. 

 
 4. The ‘Convert text to columns’ wizard will appear and has three steps.  

  

5. Step 1 - choose ‘Delimited’ under the file type section. 
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6.  Click Next. 

7. Step 2 is for setting your delimiters. A delimiter is one or more characters that separate 
text strings, such as commas, semicolon, space, brackets. 

8. Clear all except Space.  

 

Note: If you think that there are double/triple consecutive spaces between the names, then 
tick the ‘Treat consecutive delimiters as one’ box.  

9. Click Next. 

10. Step 3 is where you set the data format for your columns – do you want general, text or 
date? 
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11. This is also where you set your destination cell. As you can see, it defaults to the cell in 
which your current data is, e.g., B2 in this example. 

12. If you want the first column of the new data to overwrite your existing data (e.g. with 
the first name in the first column and last name in the adjacent column) AND the column 
after it is blank, you can leave this as it is. 

13. If you want to keep the original data intact, choose different destination cells by 
clicking the cells you want the data to go into. 

In this example, I have chosen to separate the names into the two new columns I created, 
keeping the original data column intact. Therefore, the destination is cells C2 to D9. 

  

14. Click Finish. Your data is now in separate columns. 

 

  



12 useful things to know in Excel V1 Oct  2022 15 

Putting data into middle of other cell data 
If you ever have cells in Excel that need to be merged but without some of the original 
data, you should not use Concatenate. You can, however, use this formula to place data in 
the middle of other data in a cell. 

For example, how can you get the ticket numbers in column A to go into column B to 
replace the xxxxx’s? 

 

1. This method should be done with a ‘help’ column. Select the blank cell which is next to 
the original data. Name the new column if you want. 

 
2. You will also need to count along the cell data to see at what point you want the 

‘inserted’ data to start and end. Count every character (including spaces) up to the start 
point, then up to the end point.  

3. For example, in the screenshot above, I want the 52841 in cell A2 to take the place of 
xxxxx in cell B2. Therefore, I know that the inserted data needs to start AFTER character 
number 16 (the space after CALL) and to end before character number 22 (the comma 
after the xxxxx). 

4. Now comes the formula. This might seem complicated, but this explains each part. 
 

5. In this example, I want the result in cell C2 to be exec REMOVECALL 52841,1,1 
 

6. Therefore, in the formula bar for cell C2, I put:  
=LEFT(B2,16) & A2 & MID(B2,22,100) 

 

You can see the result in cell C2. 
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7. Here is the explanation of the formula so you can adapt it to different scenarios. 

 

 

 

 

 

 = means you are starting a formula 
 LEFT indicates where to start in the new cell (here, column C) 
 (B2,16) indicates you want to start with the first 16 characters of cell B2 
 & A2 indicates to then add the data that is in cell A2 (e.g. the ticket number, the 

data to go into the middle of the original data)  
 & MID indicates to resume in the middle of the cell 
 (B2,22,100) indicates that the 22nd to 100th characters of the original cell are to 

be added after the new inserted data 

8. Once your first cell is completed, use the fill handle of that cell to drag the formula down 
through the column to populate your whole column. 

 

9. Obviously you could put text or letters into the mix instead of numbers. Any text has to 
be included in inverted commas. For example, if you need to put a D into a list name, the 
formula could look like this:  

=LEFT(A2,1) & “D” & MID(A2,2,100) 
 

 

Tip: Besides the above formula, you can also apply this formula =REPLACE(A2,2,0,”D”) 

(the number 2 indicates the location where the D is put – 2nd character of the cell data). 
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Add commands into quick access toolbar 
The quick access toolbar is the small area that runs along the very top left of your Excel 
(and Word, Outlook, PowerPoint). It gives you quick access to the commands you put 
there, rather than going along the tabs and groups to find specific commands. 

  

1. If you click onto the small downward arrow you can see some commands there for you 
to add, such as Open, Save, Quick Print, Read Aloud, Editor, Undo, Open, etc.  

 

2. However, if you choose ‘More Commands,’ a command box will open. (You can also 
reach this through File in top left of your Excel, then choosing Options and the Quick 
Access Toolbar area.) 

3. Your available-to-add commands are on the left, and your current QA toolbar 
commands are on the right. The Add and Remove buttons are in the middle. 
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4. Find what you want in the list on the left. It defaults to ‘Popular commands,’ but there 
are hundreds in total so if you can’t find what you want in that list, just use the drop-
down arrow to select something else like All Commands, Home Tab commands, Review 
commands, etc. 

   

5. Click onto the command you want to add to your quick access area and then press 
‘Add’ so it appears in the list on the right.  

For example, adding ‘Insert sheet columns’ below:  

 
6. Click on OK. 
 
7. It is now in your quick access area along the top and will remain there whenever you 

open any Excel workbook.  
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View side by side + synchro scrolling 
If you have two similar Excel workbooks and want to see them at the same time, you can 
use the ‘view side by side’ function. This allows you to compare the workbooks. 

Synchro scrolling allows you to look at the same place in both files because, when you 
scroll, it will move both files through the rows/columns at the same time. 

1. Open both of the files you want to compare. 
2. On one of the files, look for the View tab on your ribbon and then to the Window 

group. 

 
3. Click onto the ‘Arrange All’ command to choose how you want to view the files – Tiled, 

Horizontal, Vertical or Cascade. In this example, I have chosen vertical. 

 
 

4. Click ‘View side by side.’ Your documents will move to be viewed side by side on your 
screen. 
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5. To scroll both documents at the same time, click on ‘Synchronous scrolling’ command. 
(It will be greyed out until you open ‘view side by side.’) 
 

 
 
 

6. As long as both ‘view side by side’ and synchro scrolling are in grey along the top of one 
of the files, you will now be able to scroll through two Excel files to spot differences. 
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Data validation 
The data validation function in Excel helps control the kind of input entered by a user in a 
worksheet. In other words, the data typed in a specific cell must comply with the criteria 
set for that cell.  

Data validation also allows a provision of instructions about the data to be typed. The cell 
to which the data validation rule is applied is called a ‘validated cell.’ 

Examples of data validation rules: 

a. A whole number between 1 and 20 is allowed. 

b. A date is allowed to be entered which is greater than 15/09/2021 (start date) or 
lesser than 15/09/2021 (end date). 

c. A text entry is allowed which matches any of the values (“yes,” “no,” and “unsure”) 
of a drop-down list. 

Apart from setting the criteria, data validation in Excel also allows you to create a pre-
defined range of inputs – a drop-down list. This ensures that all the data entries follow the 
same format. 

1. Click into the cell for which you want to set validated data. 

2. Go into the Data tab on your Excel ribbon and find the Data Tools group. 

 

3. In the data tools group, select Data Validation. 

 

4. The Data Validation dialogue box will open: 
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5. The first tab is Settings, which contains the validation criteria. 

6. From the drop-down list under ‘Allow,’ you can select the data format to be allowed to 
users: whole number, decimal, list, date, time, text length and custom. 

 

7. For each type, a box opens for you to set the data parameters, with the Data drop-down 
field and a minimum and maximum field. 

 

7. The drop-down list under “Data” is used for defining the criteria within your chosen 
type. All options under Allow (whole number, decimal, list, date, time, text length) have 
the same Data options: between, not between, equal to, not equal to, greater than, 
less than, greater than or equal to, less than or equal to. 
 

8. For instance, if the input in the cell should be entered as a number between 5 and 10, 
select ‘whole number’ from the drop-down list under “Allow.” Then choose the 
minimum as 5 and the maximum 10. 
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10. The option of List is slightly different. If you choose List, the Data dropdown is greyed 
out and a Source box appears. Note that you can choose to use an in-cell dropdown. 

 

11. The Source box is where you set your list of choices for the validated cell(s). You can do 
these one of two ways: 

(a) type in your list.  
(b) have your list on another tab already typed out. 
 
11a. If you choose to type the list in Source, just input your list with a comma between 
each item: 

 
 
A dropdown box will now appear in your cell:  

 
 
11b. If you choose the tab method, write your choices on separate lines of another tab  
(here called Data Options) 

 
 
Tip: if you think you will have extra list items to add later, always include some blank 
lines in this method. That way when you add them to your tab list, the formula still 
covers all of your list. 
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Click onto those cells while you are within the Source box. Excel will input the formula 
for those cells (e.g., Data Options cells A1 to A4) 

 

This method will give you the same drop-down list as typing directly into Source. 

 

12. The tick-box “ignore blank” is selected by default. This selection tells Excel to ignore the 
blank values. 

 

13. The second tab in the Data Validation box is “Input message”. You can enter a title and 
a message, which are displayed when a validated cell is selected. 

 
 
Note: An “input message” is optional and tells the user about the kind of input allowed in 
a validated cell. But if you do add an input message, ensure that the “show input message 
when cell is selected” box is ticked. 
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14. The third tab is ‘Error Alert’ where you can enter a title and error message that are 
displayed when invalid data is typed in. 

 
15. From the “Style” drop-down, you can select any of the three options: Stop, Warning or 
Information. 

 
Note: An “error message” is optional and is a customised message which tells the user that 
they have made an error while typing data in the validated cell. 
 If an error message is added, ensure that the “show error alert after invalid data is 
entered” box is ticked. 
 If not added, Excel displays the default error message, which states that restrictions have 
been defined for the validated cell. 
 

16. Once the entries in tab(s) you want have been defined, click “Ok” in the “data 
validation” window. 
 
17. The data validation Excel rule is applied to the selected range of cells. You can create a 
data validation rule by selecting either a single cell or a range of cells in Excel. 

 
Note: For creating a data validation rule, it is mandatory to enter the validation criteria in 
the “settings” tab (step 5). However, it is optional to define the tabs “input message” and 
“error alert.” 

 


